BOARD OF REGENTS OF HIGHER EDUCATION

ACADEMIC AFFAIRS

PROCEDURAL GUIDEBOOK

PROCEDURES AND GUIDELINES FOR ACADEMIC SUBMISSIONS TO THE BOARD OF REGENTS

OFFICE OF THE COMMISSIONER OF HIGHER EDUCATION

CLAYTON T. CHRISTIAN, COMMISSIONER

560 N. Park Ave. PO Box 203201
Helena, MT 59620-3201
Phone (406) 449.9124
Fax (406) 449.9171
http://www.mus.edu/

Revised 2/21/2020

Contact: Rebecca Power (406) 449.9143 rpower@montana.edu
Joseph Thiel (406) 449.9134 jthiel@montana.edu
Brock Tessman (406) 449.9129 btessman@montana.edu
Contents

Acronyms

Due Dates and Timelines

Academic Proposals

A. Level I Items

Campus Approvals
1. Moratoriums
2. Campus certificates
3. Establishing a B.A.S./A.A./A.S. area of study
4. Offering an existing postsecondary educational program via distance or online delivery

OCHE Approvals
5. Re-titling an existing postsecondary educational program
6. Terminating an existing postsecondary educational program
7. Consolidating existing postsecondary educational programs
8. Establishing a new minor where there is a major or an option in a major
9. Revising a postsecondary educational program
10. Establishing a temporary C.A.S. or A.A.S. degree program

B. Request to Plan, Level II Academic Proposals, and Academic Unit Proposals
11. Establishing a new postsecondary educational program
12. Permanent authorization for a temporary C.A.S. or A.A.S. degree program
13. Exceeding the 120-credit maximum for baccalaureate degrees
14. Forming, eliminating or consolidating an academic, administrative, or research unit
15. Re-titling an academic, administrative, or research unit

Academic Priorities and Planning Statement

Level II Academic Program Follow-up

Academic Program Reviews

Campus Mission Review and Core Themes
1. Mission Statement Review
2. Mission Statement Revisions
3. Revision of Core Themes

Formatting Agenda Items

Numbering Agenda Items

Forms and Templates

Ensuring Academic Items Meet Web Accessibility Requirements

Appendix A

Appendix B - Guidelines on Proposing Research Centers/Institutes

Appendix C - Guidance for the Fiscal Analysis Form
ACRONYMS

A.A. / A.S.  Associate of Arts (A.A.) and Associates of Science (A.S.) transfer associate degrees
A.A.S.  Associate of Applied Science, a terminal (not transfer) associate degree
ARSA  Academics, Research, and Student Affairs
B.A.S.  Bachelor of Applied Science, a specialized bachelor’s degree that builds on the A.A.S. degree
BOR  Board of Regents
CAO  Chief Academic Officer
CC  Community Colleges (i.e. Dawson, Flathead, and Miles City)
CIP  Classification of Instructional Program codes
CHE  Commissioner of Higher Education
DC  Deputy Commissioner for Academic Research and Student Affairs
IPEDS  Integrated Postsecondary Education Data System
LI  Level I Proposal
LII  Level II Proposal
NCES  National Center for Educational Statistics
OCHE  Office of the Commissioner of Higher Education
RTP  Request to Plan

DUE DATES AND TIMELINES

The most up to date Board of Regents (BOR) meeting schedule can be found at:
http://mus.edu/board/meetings/meetingschedule.asp

The general submission deadlines and approval schedule for academic proposals is as follows:

Academic Priorities and Planning Statement
- Due on Wednesday, seven weeks before the July BOR meeting.
- OCHE will distribute to CAOs and ARSA BOR Committee members five weeks prior to July BOR meeting.
- Institutions will be notified three weeks prior to the July BOR meeting if the ARSA committee or full BOR require a presentation of the Academic Priorities and Planning Statement.

Final Approval (Levels I and II) Items
- Level I and Level II items for final OCHE approval are due monthly on Tuesday, three weeks before the chief academic officer (CAO) call.
- The Office of the Commissioner of Higher Education (OCHE) will send out all items and proposals one week after they are received (two weeks before the monthly CAO call).
- The monthly CAO call is held on the third Tuesday of every month.
- Within one week after the monthly CAO call, OCHE will finalize all necessary approvals and inform the CAOs of the decision.
**Request to Plan and Academic Unit Items**

- Request to Plan and Academic Unit items are due on Wednesday, seven weeks before the BOR meeting (five weeks before the CAO BOR call).
- OCHE will send out Request to Plan items one week after they are received (four weeks before the CAO BOR call).
- The CAO BOR call will be held on Wednesday, two weeks before the BOR meeting.
- Final comments must be received by OCHE by the Friday after the CAO BOR call (one week before the Academic, Research and Student Affair (ARSA) committee BOR call).
- The ARSA BOR call will be held on the Monday before the BOR agenda goes live.
- The BOR agenda goes live Wednesday, one week before the BOR meeting.

For a complete schedule, please visit: [http://mus.edu/che/arsa/ARSA_Approval_Schedule.pdf](http://mus.edu/che/arsa/ARSA_Approval_Schedule.pdf)

All items should be submitted directly to Joseph Thiel and Rebecca Power.

*Note: These deadlines are established for the submission of academic items to OCHE only. The flagship institutions are responsible for making their respective campuses aware of any campus submission deadlines.*

The Deputy Commissioner for Academic and Student Affairs will send out a memo with their signature notifying the CAO of the items approved for their institution following approval by OCHE or the BOR.

**ACADEMIC PROPOSALS**

As indicated in [BOR Policy 303.1 Academic Program Proposals](http://mus.edu/che/arsa/ARSA_Approval_Schedule.pdf), the Commissioner of Higher Education (CHE) shall establish a process whereby institutions of the Montana University System (MUS) and community colleges (CC) may propose new postsecondary educational program offerings or modifications to existing offerings. Herein contained are the details and guidelines of that process.

**Definitions**

**Postsecondary Educational Program**: A series of courses arranged in a scope or sequence leading to a degree, certificate, option, major, or minor where a major does not already exist ([BOR Policy 303.1](http://mus.edu/che/arsa/ARSA_Approval_Schedule.pdf)).

**Academic, Administrative, or Research Unit**: A college, division, school, department, institute, bureau, center, station, laboratory or similar unit within the institutional organization of a college or university ([BOR Policy 218 Institutional Organization](http://mus.edu/che/arsa/ARSA_Approval_Schedule.pdf)).

**Degree**: A specific designation of letters representing the words on the diploma indicating completion or attainment. Examples: certificate of technical studies (C.T.S.), certificate of applied science (C.A.S.), associate of arts (A.A.), associate of science (A.S.), associate of applied science (A.A.S), bachelor of applied science (B.A.S.), bachelor of arts (B.A.), bachelor of science (B.S.), master of arts (M.A.), master of fine arts (M.F.A.), doctor of education (Ed.D.), doctor of philosophy (Ph.D), etc. ([BOR Policy 303.1](http://mus.edu/che/arsa/ARSA_Approval_Schedule.pdf)).
Determining the Level of Involvement of the Board

Three factors determine the level to which OCHE and the BOR become directly or indirectly involved in the process of approving or denying the development, implementation, suspension and/or elimination of academic and research programs and entities:

1. The degree to which the proposed program fits an institution’s approved mission.
2. The relationship between resources needed, resources available, and the projected benefit.
3. The significance of programmatic impact on other institutions within the MUS and CC.

The academic proposal approval process includes the following two levels of submissions:

<table>
<thead>
<tr>
<th>A. Level I</th>
<th>B. Request to Plan and Level II</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Campus Approvals</strong></td>
<td><strong>BOR &amp; OCHE Approvals</strong></td>
</tr>
<tr>
<td>1a. Placement of a postsecondary educational program into moratorium</td>
<td>11. Establishing a new postsecondary educational program</td>
</tr>
<tr>
<td>1b. Withdrawing a postsecondary educational program from moratorium</td>
<td>12. Permanent authorization of a temporary C.A.S or A.A.S. degree program</td>
</tr>
<tr>
<td>2. Establishing, re-titling, terminating or revising a campus certificate of 29 credits or less</td>
<td>13. Exceeding the 120-credit maximum for baccalaureate degrees</td>
</tr>
<tr>
<td>3. Establishing a B.A.S./A.A./A.S. area of study</td>
<td>14. Forming, eliminating or consolidating an academic, administrative, or research unit</td>
</tr>
<tr>
<td>4. Offering an existing postsecondary educational program via distance or online delivery</td>
<td>15. Re-titling an academic, administrative, or research unit</td>
</tr>
<tr>
<td><strong>OCHE Approvals</strong></td>
<td></td>
</tr>
<tr>
<td>5. Re-titling an existing postsecondary educational program</td>
<td></td>
</tr>
<tr>
<td>6. Terminating an existing postsecondary educational program</td>
<td></td>
</tr>
<tr>
<td>7. Consolidating existing postsecondary educational programs</td>
<td></td>
</tr>
<tr>
<td>8. Establishing a new minor where there is a major or an option in a major</td>
<td></td>
</tr>
<tr>
<td>9. Revising a postsecondary educational program</td>
<td></td>
</tr>
<tr>
<td>10. Establishing a temporary C.A.S. or A.A.S. degree program</td>
<td></td>
</tr>
</tbody>
</table>

**A. Level I Items**

Level I items are those requests for which the BOR has fully designated approval authority to the institution or OCHE. These requests are to be submitted for notification to or approval by OCHE as Level I proposals. Level I proposals may be submitted to OCHE at any time by the flagship campuses or CC and will be processed on a rolling monthly schedule. The approval of such proposals will be conveyed to the BOR at the next meeting of the board. Level I proposals include campus initiatives typically characterized by minimal costs, clear
adherence to approved campus mission, and the absence of significant programmatic impact on other institutions within the MUS and CC.

Campus Approvals
As Level I campus approvals are notifications to OCHE and the BOR, the title of these items should always begin as follows: Notification of...

For example: Notification of the establishment of a C.T.S. in Business

1. Moratoriums
   a) Placing a postsecondary educational program into moratorium
   When an institution determines that it cannot offer an existing postsecondary educational program under current circumstances but does not wish to terminate the program entirely the BOR defers to local decisions by allowing the campus to put the program into moratorium for up to three years without regental approval. The program in moratorium remains in the college catalog and courses needed to continue the progression of existing students to degree completion are provided, but no new students are admitted to the program. The BOR imposes two restrictions for programs placed in moratorium:

   • The campus must formally notify the BOR of the decision to put the program into moratorium and the effective date of that decision. It is the responsibility of the campus to monitor their programs in moratorium.
   • If the campus has not withdrawn the program from moratorium within three years of the effective date of the moratorium, the BOR considers the program to be terminated.

   It is the campus’s responsibility to submit the proper termination paperwork to ensure a program in moratorium is removed from the MUS program inventory.

   Notification of the placement of a program into moratorium should be submitted with an Academic Proposal Request Form, and Program Termination/Moratorium Form.

   b) Withdrawing a postsecondary educational program from moratorium
   When withdrawing a postsecondary educational program from moratorium the campus must submit notice of their decision to reinstate the program.

   Notification of the withdrawal of a program from moratorium should be submitted with an Academic Proposal Request Form.

2. Campus certificates
   Certificate programs of 29 credits or fewer may be established, retitled, terminated, or revised by the campuses of the MUS and CC without approval by the BOR. All such certificates shall be reported to OCHE via a Level I proposal and thereby listed on the official degree and program inventory of the system.
Notification of the establishment, re-titling, termination, or revision of a campus certificate requires an Academic Proposal Request Form and additional supporting materials as deemed necessary by the institution.

3. Establishing a B.A.S./A.A./A.S. area of study
Units of the MUS are authorized to award the B.A.S. degree, a specialized baccalaureate degree that builds on an A.A.S. degree. Because an A.A.S. degree is ordinarily considered a terminal credential, guidelines for the B.A.S. degree are appropriate. Areas of concentration are customized to connect the student’s A.A.S. degree and educational/occupational goals. The A.A. and A.S. degrees are general transfer degrees. A.A. and A.S. degrees do not officially include a major or minor course of study. All areas of study within B.A.S./A.A./A.S. degrees shall be reported to OCHE via a Level I proposal and thereby listed on the official degree and program inventory of the system.

Notification of a B.A.S./A.A./A.S. area of study requires an Academic Proposal Request Form and additional supporting materials as deemed necessary by the institution.

4. Offering an existing postsecondary educational program via distance or online delivery
Offering an existing postsecondary educational program online or at a location other than the originally authorized home site requires the campus to submit notification of the change in delivery.

Notification of the offering of a program via distance or online delivery should be submitted with an Academic Proposal Request Form.

OCHE Approvals

As Level I OCHE approvals are requests to OCHE, the title of these items should always begin as follows: Request for authorization to...

For example: Request for authorization to establish a minor in Chemistry

5. Re-titling an existing postsecondary educational program
Changing the title of an existing postsecondary educational program requires approval by OCHE. (This does not include the change in type of degree, for example a B.A. to a B.S. This type of change is equivalent to establishing a new program.)

Requesting authorization to re-title an existing program requires an Academic Proposal Request Form and additional supporting materials as deemed necessary by the institution.

6. Terminating an existing postsecondary educational program
Terminating an existing postsecondary educational program and permanently removing it from the college offerings requires approval by OCHE.

Requesting authorization to terminate an existing program should be submitted with an Academic Proposal Request Form and Program Termination/Moratorium Form.
7. Consolidating existing postsecondary educational programs
When consolidating two or more existing postsecondary educational programs, campuses must request approval from OCHE.

Requesting authorization to consolidate existing programs should be submitted with an Academic Proposal Request Form, Curriculum Proposal Form, and additional supporting materials as deemed necessary by the institution.

8. Establishing a new minor where there is a major or an option in a major
Adding a new minor where a major or option in a major already exists requires approval by OCHE.

Requesting authorization to add a new minor should be submitted with an Academic Proposal Request Form, Curriculum Proposal Form, and additional supporting materials as deemed necessary by the institution.

9. Revising a postsecondary educational program
Other types of significant curriculum changes that do not fit another type of request may be submitted as a program revision to ensure adequate approval by OCHE and notification to the BOR. Example: significantly altering the number of credits of an existing program (but not exceeding the credit maximum established in Policy 301.11). If you are unsure of whether a change is significant, please contact Joseph Thiel and Rebecca Power who can provide case-by-case guidance.

Requesting authorization to revise a program requires an Academic Proposal Request Form, Curriculum Proposal Form and additional supporting materials as deemed necessary by the institution.

10. Establishing a temporary C.A.S. or A.A.S. degree program
OCHE may grant temporary approval for C.A.S. or A.A.S. degree programs that are offered in cooperation with and/or at the request of private or public sector partners and when the decision point to offer the program is not consistent with the regular BOR program approval process. Level I approval for programs under this provision is limited to two years. Continuation of a program beyond the two years will require the institution to complete the “Permanent authorization for a temporary C.A.S. or A.A.S. degree” Level II approval process.

Requesting authorization to add a temporary C.A.S. or A.A.S. degree should be submitted as a Level I proposal and include an Academic Proposal Request Form specifying the reason for the expedited request, and additional supporting materials as deemed necessary by the institution.

B. Request to Plan, Level II Academic Proposals, and Academic Unit Proposals
Level II proposals require initial approval and comment by the BOR through a Request to Plan prior to final review and approval by OCHE. These proposals entail more substantive additions to, alterations in, or termination of programs, structures, or administrative or academic entities typically characterized by the (a) addition, reassignment, or elimination or personnel, facilities, or courses of instruction; (b) rearrangement of
budgets, cost centers, funding sources; and (c) changes which by implication could impact other campuses within the MUS and CC.

As Level II items and Request to Plans are requests to the BOR and/or OCHE, the title of these items should always begin as follows: Request for authorization to...

For example, for a Request to Plan: Request for authorization to plan a B.A. in History
For example, for a Level II Proposal: Request for authorization to establish a B.A. in History

11. Establishing a new postsecondary educational program
Establishing a new postsecondary educational program requires campuses to complete a two-step process that begins at idea conception, proceeds through BOR review and comment, and concludes with approval from OCHE. This process for new postsecondary educational programs is meant to increase communication, review, and collaboration early on in the development process among the BOR, other institutions of the MUS and CC, and OCHE. For a visual representation of this process, see Appendix A.

Request to Plan: In the first stages of development of a new postsecondary educational program or academic, research, or administrative unit campuses should submit a Request to Plan (ITP) to notify the other institutions of the MUS and CC, OCHE, and the BOR of a proposed program. This notification will allow for early collaboration and discussion to occur among and between concerned parties and provide an early formal opportunity for the BOR to comment on the programs suitability and fit with the campus mission and state need. ITPs are submitted to OCHE with the approval signatures of the college/school dean, CAO, chief executive officer, flagship provost, and flagship president as applicable depending on the institution. Requests may be submitted at any regular meeting of the BOR (March, May, September, November) for review by OCHE, the MUS and CC CAOs, and the ARSA committee of the BOR before moving forward to the ARSA action agenda for a regental vote. The BOR or OCHE in their approval of a Request to plan may include commentary or direction to guide the campus or OCHE in development and final review of the proposed program.

The approved request to plan will be posted to a public webpage of the Montana University System website where they will remain until a full proposal is submitted or they are halted upon the request of the proposing institution or after 18 months from the final date of review, whichever comes first. If an institution desires an extension to their approval, it should send a letter to the Deputy Commissioner for ARSA that lists the anticipated date of final Level II submission and provides justification for the extension.

Please note, the submission of a Request to Plan does not guarantee the submission of a full Level II proposal, nor does the approval of a Request to Plan guarantee the approval of the full Level II proposal.

A Request to Plan proposal requires a Request to Plan and additional supporting materials as deemed necessary by the institution.

After receipt of a Request to Plan, OCHE will add contextual information for the CAOs and Regents. This contextual information will include, to the degree available:
• Labor market information sourced from the Montana Department of Labor and Industry, O*NET, the National Science Foundation, or a job board aggregator.

• Graduates from other MUS programs at the same level in related areas (as defined by CIP codes) for the prior three years. This information will be sourced from either IPEDS or the MUS Student Data Warehouse.

**Level II Proposal:** Having fully and successfully completed the Request to Plan step of the new postsecondary educational program or academic, research, or administrative unit submission process, campuses may submit on a rolling monthly basis a Level II proposal for the new postsecondary educational program. Upon receipt of the Level II proposal by OCHE from the flagship campus or CC, the proposal will undergo review by OCHE and the MUS and CC CAOs before being considered by OCHE for final approval. The approval of such proposals will be conveyed to the BOR as an information item at the next meeting of the board.

A Level II Proposal for a new academic program requires an [Academic Proposal Request Form](#), [Curriculum Proposal Form](#), [Fiscal Analysis Form](#), signed [Request to Plan](#) and additional supporting materials as deemed necessary by the institution. Guidance for the Fiscal Analysis Form is included as [Appendix C](#).

### NOTE ON CIP CODES:

Request to Plan, Level I, and Level II items require campuses to list a 6-digit Classification of Instructional Program (CIP code). These codes are set by the National Center for Educational Statistics (NCES) and are vitally important for tracking student progress and outcomes both within the Montana University System and the Integrated Postsecondary Data System (IPEDS). NCES maintains several tools to help identify the correct CIP code for an academic program at their website: [https://nces.ed.gov/ipeds/cipcode/browse](https://nces.ed.gov/ipeds/cipcode/browse). Please ensure that you are using the most up to date CIP classifications (CIP 2020).

### 12. Permanent authorization for a temporary C.A.S. or A.A.S. degree program

C.A.S or A.A.S. degree programs granted temporary authorization must seek further authorization from OCHE within two years. Campuses may submit a Level II proposal on a rolling monthly basis. Upon receipt of the Level II proposal by OCHE from the flagship campus or CC, the proposal will undergo review by OCHE and the MUS and CC CAOs.

Requesting permanent authorization for a temporary C.A.S. or A.A.S. program requires an [Academic Proposal Request Form](#), [C.A.S./A.A.S. Curriculum Proposal Form](#), [Fiscal Analysis Form](#) and additional supporting materials as deemed necessary by the institution. Guidance for the Fiscal Analysis Form is included as [Appendix C](#).

### 13. Exceeding the 120-credit maximum for baccalaureate degrees

To require more than 120 semester hours of credit for a baccalaureate degree, campuses must seek approval from the BOR and OCHE for an exception to [BOR Policy 301.11 Undergraduate Degree Requirements](#). The proposal must document the rationale for the exception based on one of the following criteria:
• Accreditation standards of the appropriate specialized accrediting agency mandate a baccalaureate program of over 120 credit hours.
• Licensing standards of the profession involved require a baccalaureate program of over 120 credit hours.
• Employment and initial success in the profession require a baccalaureate program of over 120 credit hours.

Requesting authorization to exceed the 120 credit maximum for baccalaureate degrees requires an Academic Proposal Request Form specifying the rationale for the request, and additional supporting materials as deemed necessary by the institution.

14. Forming, eliminating or consolidating an academic, administrative, or research unit
Forming a new college, division, school, department, institute, bureau, center, station, laboratory or similar unit requires campuses to seek BOR approval through the two-step process described above for new postsecondary proposals. This process is represented in a flow chart in Appendix A. Guidelines specific to research centers and institutes have been provided in Appendix B.

When eliminating or consolidating an existing college, division, school, department, institute, bureau, center, station, laboratory or similar unit, campuses must request approval from the BOR.

Requesting authorization to form a new academic, administrative, or research unit requires an Academic Proposal Request Form, Center/Institute Proposal Form (for centers and institutes only), signed Request to Plan Form, and additional supporting materials as deemed necessary by the institution.

Requesting authorization to eliminate an existing academic or research unit requires an Academic Proposal Request Form, signed Request to Plan Form and additional supporting materials as deemed necessary by the institution.

Requesting authorization to consolidate two or more existing academic, administrative, or research unit requires an Academic Proposal Request Form, Center/Institute Proposal Form (for centers and institutes only), signed Request to Plan Form, and additional supporting materials as deemed necessary by the institution.

15. Re-titling an academic, administrative, or research unit
When re-titling an existing college, division, school, department, institute, bureau, center, station, laboratory or similar unit, campuses must seek BOR approval through an Academic Unit Proposal. These items require a BOR vote, so must be submitted to OCHE seven weeks prior to a BOR meeting, on the same timeline as Request to Plans.

Requesting authorization to re-title an existing academic or research unit requires an Academic Proposal Request Form and additional supporting materials as deemed necessary by the institution.
ACADEMIC PRIORITIES AND PLANNING STATEMENT

In order to inform the BOR regarding institution’s academic directions and encourage ongoing prioritization of academic programs, each campus will file an Academic Priorities and Planning Statement Template with the OCHE annually eight weeks prior to the July meeting of the BOR.

This report should include:

- A high-level overview of the institution’s current academic priorities (instruction and research), with a focus on how those priorities fit with the institutional mission and current strategic plan.
- A description of the process used to determine these academic priorities.
- A description highlighting new academic or research programs that the institution hopes to pursue in the coming year, with a focus on how those new programs will support your academic priorities.
- If/where applicable, a high-level overview of areas that will be somewhat less prioritized, including any areas in which your campus will consider disinvestment, moratorium, and/or termination.
- Additional details you find relevant for the BOR to consider as they make decisions about “Requests to Plan.”

Along with this statement, institutions should submit a Forthcoming Academic Proposals spreadsheet describing academic programs or research centers/institutes that the institution anticipates may proceed to the “Request to Plan” portion of the approval process in the coming year. A proposal need not be listed in this report to proceed to the “Request to Plan” stage. However, listing proposals likely to move forward is an appreciated courtesy intended to encourage early communication and collaboration.

LEVEL II ACADEMIC PROGRAM FOLLOW-UP

Postsecondary education programs approved under the Level II “New postsecondary program” option will be reviewed during their third and fifth years of operation. Postsecondary education programs initially approved under the Level I “Establishing a temporary C.A.S. or A.A.S. program” option and then approved under the Level II “Permanent authorization for C.A.S. or A.A.S. programs” option will be reviewed during their fifth year of operation. The community colleges are exempt from this review.

- Each September, OCHE will calculate annual unduplicated headcount enrollment (from declared majors/minors) and graduates in academic programs slated for review.
- In their third year of operation, programs approved under the Level II “New postsecondary program” option whose actual headcount is less than that projected in the fiscal analysis form submitted as a part of the Level II proposal will be asked to submit a Level II Academic Program Follow-up Form, and a Level II Fiscal Analysis Follow-up Form to OCHE on the same timeline as November Request to Plan submissions (seven weeks prior to the November BOR meeting). An Item Template is NOT required for submission of Academic Program Follow-up forms. This information will be reviewed by OCHE staff and will appear as an information item on the November BOR agenda.
In their fifth year of operation, programs approved under either the Level II “New postsecondary program” option or the Level II “Permanent authorization for C.A.S or A.A.S programs” option whose actual headcount is 70% or less of that projected in the fiscal analysis form submitted as a part of the Level II proposal will be placed into moratorium. Programs whose actual headcount enrollment falls between 70 and 100% of that projected in the original level II proposal will be asked to submit a Level II Academic Program Follow-up Form, a Level II Fiscal Analysis Follow-up Form, and a detailed plan for improvement to OCHE on the same timeline as November Request to Plan submissions (seven weeks prior to the November BOR meeting). The ARSA Deputy Commissioner will review the submitted materials and make a recommendation to the BOR regarding whether the program should be placed into moratorium or continue. The BOR will then vote on the ARSA Deputy Commissioner’s recommendation at the November meeting of the BOR.

The guidance in Appendix C for the Fiscal Analysis Form applies also to the Level II Fiscal Analysis Follow-up Form.

ACADEMIC PROGRAM REVIEWS

All of the institutions that make up the MUS, excluding the CC, are required by BOR Policy 303.3 Program Review to conduct internal reviews of their academic programs to ensure program quality and effective stewardship of resources. All programs listed in the official degree and program inventory, except for certificates of 29 credits or less, must be reviewed at least once every seven years. The program review schedules are filed with OCHE and can be found at http://mus.edu/che/arsa/ProgramReview/ProgramReview.asp.

Academic program reviews for the previous academic year are to be submitted at each November BOR meeting according to the regular item schedule. The reviews are considered as an information item and should be submitted using the Academic Program Review Template. An Item Template is NOT required for submission of program reviews.

CAMPUS MISSION REVIEW AND CORE THEMES

1. Mission Statement Review
Board of Regents Policy 219 – Mission Statements; Montana University System requires that the Board review campus’ mission statements every three years. Mission reviews are to be submitted as an Action item with other “regular” Board Items using the Item Template and Mission Statement Review Template.
### Mission Review Schedule

<table>
<thead>
<tr>
<th>Month</th>
<th>Institutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>September</td>
<td>MSU – Bozeman</td>
</tr>
<tr>
<td></td>
<td>UM – Missoula</td>
</tr>
<tr>
<td>November</td>
<td>Montana Tech</td>
</tr>
<tr>
<td></td>
<td>MSU – Billings</td>
</tr>
<tr>
<td></td>
<td>MSU – Northern</td>
</tr>
<tr>
<td></td>
<td>UM – Western</td>
</tr>
<tr>
<td>March</td>
<td>Helena College UM</td>
</tr>
<tr>
<td></td>
<td>Great Falls College MSU</td>
</tr>
</tbody>
</table>

### 2. Mission Statement Revisions

Board of Regents’ [Policy 303.1 – Curriculum Proposals](http://mus.edu/che/arsa/Forms/AcademicForms.asp) states that any revision of an institutional mission shall be reviewed and approved by the Board of Regents. Mission revisions are to be submitted as an Action item using the [Item Template](http://mus.edu/che/arsa/Forms/AcademicForms.asp) and any additional supporting documentation.

### 3. Revision of Core Themes

The revision of an institution’s core themes shall be reviewed and approved by the Board of Regents. The revision of core themes shall be submitted as an Action item using the [Item Template](http://mus.edu/che/arsa/Forms/AcademicForms.asp).

### Formatting Agenda Items

Agenda items should be prepared using the academic forms available online at [http://mus.edu/che/arsa/Forms/AcademicForms.asp](http://mus.edu/che/arsa/Forms/AcademicForms.asp).

All items should include at a minimum the Academic Proposal Request Form. All supporting materials must be listed in the Academic Proposal Request Form under ATTACHMENTS. Additional materials must include the item number and a description of the document in the header. For example:

```
ITEM #147-1000-R0510
Attachment #1-Letter of Support
```

Please follow the formatting tips below for all items and supporting materials:

- Submit materials in Word.doc format when possible
- Use Calibri font size 11
- Use the least number of pages necessary for easier displaying purposes

Please save the items using the item number, utilizing hyphens rather than periods. The filename for supporting materials should include the item number and a brief notation of what the document is. Please see below for examples of filenames:

- Academic Proposal Request Form 147-1000-R0510
- Curriculum Proposal 147-1000-R0510_Curr
- Program Termination Form 147-1000-R0510_Term
- Fiscal Analysis Form 147-1000-R0510_Fisc
- Attachment #1 147-1000-R0510_A1
**NUMBERING AGENDA ITEMS**

If you have questions on numbering BOR Items, please call Amy Unsworth at (406) 444-0374, or e-mail aunsworth@montana.edu.

---

**ITEM** | **AAA** - **BBBB** - **C** **DDDD**

---

A. The first three digits of an item number will be assigned by the OCHE office and communicated to campuses approximately one month in advance of the item due dates.

B. The second set of numbers identifies the unit submitting the item, be it a campus, MUS/OCHE. The assigned numbers are as follows:

<table>
<thead>
<tr>
<th>Campus</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Montana University System</td>
<td>100</td>
</tr>
<tr>
<td>Officer of the Commissioner of Higher Education</td>
<td></td>
</tr>
<tr>
<td>Community Colleges (General)</td>
<td>150</td>
</tr>
<tr>
<td>Dawson Community College</td>
<td>200</td>
</tr>
<tr>
<td>Flathead Valley Community College</td>
<td>300</td>
</tr>
<tr>
<td>Miles Community College</td>
<td>400</td>
</tr>
<tr>
<td><strong>UM</strong></td>
<td></td>
</tr>
<tr>
<td>The University of Montana – Missoula</td>
<td>1000</td>
</tr>
<tr>
<td>Montana Technological University</td>
<td>1500</td>
</tr>
<tr>
<td>Montana Bureau of Mines and Geology</td>
<td>1500A</td>
</tr>
<tr>
<td><strong>UM</strong> – Western</td>
<td></td>
</tr>
<tr>
<td>UM – Western</td>
<td>1600</td>
</tr>
<tr>
<td><strong>MSU</strong></td>
<td></td>
</tr>
<tr>
<td>Montana State University – Bozeman</td>
<td>2000</td>
</tr>
<tr>
<td>MSU – Agricultural Experiment Station</td>
<td>2300</td>
</tr>
<tr>
<td>MSU – Cooperative Extension Service</td>
<td>2400</td>
</tr>
<tr>
<td>MSU – Billings</td>
<td>2700</td>
</tr>
<tr>
<td>MSU – Northern</td>
<td>2800</td>
</tr>
<tr>
<td>Great Falls College – MSU</td>
<td>2900</td>
</tr>
</tbody>
</table>
Staff items will always end in 00. All other items are numbered sequentially, beginning with 01.

**Example:** ITEM 147-1000-R0510 is a staff item from The University of Montana-Missoula; ITEM 147-1001-R0510 is an additional UM item.

C. The letter just prior to the final set of numbers represents the meeting type. This is usually an "R" to reflect agenda items submitted for regular BOR meetings. However, the following letters may also be used as applicable:

- C Conference Call Meeting
- S Special Meeting
- W Workshop
- LI Level I Item
- LII Level II Item

**Example:** ITEM 147-1000-R0510 is an item for a regular meeting. ITEM 147-1000-C0510 would be an item for a conference call meeting.

D. The last four numbers represent the month and year of a meeting.

**Example:** ITEM 147-1000-R0510 is an item for the May 2010; ITEM 147-1000-R1010 is an item for an October 2010.

E. The numbering of Level I and Level II academic items is slightly different than other BOR items and should be completed as follows:

ITEM BBBB-LIDDDD

- **BBBB** The campus identifier. See the Board Agenda Handbook to determine your campus designation.
- **LI** The submission type. LI represents only Level I items. LII represents Level II items.
- **DDDD** The month and last two digits of the year the item is submitted to OCHE

OCHE will assign the appropriate assigned meeting number typically included on BOR items in the memo presented to the BOR listing approved Level I proposals.

Request to Plan and Mission Statement revisions should include the OCHE assigned meeting number.

**FORMS AND TEMPLATES**

All forms are available on the ARSA web page: [https://mus.edu/che/arsa/Forms/AcademicForms.asp](https://mus.edu/che/arsa/Forms/AcademicForms.asp)
ENSURING ACADEMIC ITEMS MEET WEB ACCESSIBILITY REQUIREMENTS

The Montana University System and the Office of the Commissioner of Higher Education are committed to ensuring that people with disabilities have equal access to programs, benefits, and services pursuant to Section 504 of the Rehabilitation Act of 1973 and the Americans with Disabilities Act of 1990. This includes providing all users with the ability to access electronic content. MUS is currently working to improve the accessibility of its electronic content by complying with W3C’s Web Content Accessibility Guidelines (WCAG) 2.0 Level AA and the Web Accessibility Initiative Accessible Rich Internet Applications Suite (WAI-ARIA) 1.0 (see https://mus.edu/accessibility.asp).

- A major portion of academic approval documents in PDF. It is best to ensure that the source document (Word, Excel, PowerPoint, etc.) is accessible prior to generating a PDF. After the PDF is generated, there may be additional steps to perform on the PDF within Adobe Acrobat to ensure that the PDF is accessible.

- Microsoft Office and Adobe Acrobat include built-in accessibility checkers. It is strongly recommended that these built-in checkers be utilized to identify and resolve accessibility issues prior to submitting documents for posting on the MSU.edu website.

Microsoft Office Format

Office documents must be in the newer Office format in order to use the Accessibility Checker. When you open a document in Word 2016 or Word 2013 that was created in Word 2007 or Word 2010, you see Compatibility Mode in the title bar of the document window. If you open a Word 2013 document in Word 2016, you don't see Compatibility Mode because Word 2013 and Word 2016 are already compatible.

If you see Compatibility Mode in the title bar, convert the document to the newer format so that you can use the Accessibility Checker. Here’s how:

1. Select File > Info > select Compatibility Mode

2. If your document is heavily formatted, you may want to first check to see what issues may arise when converting

   Select File > Info > Inspect Document section, select Check for Issues > Check Compatibility.
3. Click **Select versions to show**. A check mark that appears next to the name of the mode that the document is in.

4. When ready to convert to the newer format, select **File > Info > select Compatibility Mode**. Press “OK” in the pop-up box.

**Working with the Academic Forms**

The [MUS Academic Forms](#) have been created with accessibility in mind, however, additional manual steps are required when submitting items to OCHE.

A document **Title** must be added in the document properties of the file you are submitting. Select **File > Info** and modify the Title found on the right-hand side of the Info menu. Add either the Item # after the word ITEM for Board items or add other information which accurately describes the document. For item addenda and attachments, please enter the item number and the addendum or attachment number in the Title in the file properties.

Additional properties may also be set here, such as adding tags or comments.
Use the Microsoft Office Accessibility Checker

When your document is finalized, run the Microsoft Office built-in accessibility checker and address any issues that arise. Common issues that must be fixed include adding alternate text for images and removing extra spaces where possible. Other items may be a little more difficult to address. For specific information on identifying and fixing accessibility issues in Microsoft Office documents, visit “Make your content accessible to everyone” on the Microsoft website. There are a lot of resources available there, including training videos.

1. On the ribbon, click the Review tab then click Check Accessibility.
2. The **Accessibility Checker** task pane appears next to your content and shows the inspection results.

![Accessibility Checker](image)

3. To see information on why and how to fix an issue, under **Inspection Results**, select an issue. Results appear under **Additional Information**, and you’re directed to the inaccessible content in your file.

4. See [Rules for the Accessibility Checker](#) for more information.

**Don't see Accessibility Checker?**

If you don't see the **Check Accessibility** button on the **Review** tab, you might have an older version of Word, Excel or PowerPoint. Follow these steps to open the accessibility checker.

1. Click **File > Info**.

2. Select the **Check for Issues** button.

**Tip:** To the right of the **Check for Issues** button, under the **Inspect** heading, is a list of any potential issues.

![Check for Issues](image)

3. In the **Check for Issues** drop-down menu, select **Check Accessibility**.
Creating PDFs

1. To convert your Office document to PDF, use “Save As” and then select PDF from the file type drop down list, but do not click Save yet. Instead, click More options.…

2. Make sure “Document structure tags for accessibility” is checked. If the document has several sections with headings, also choose the “Create bookmarks using:” and then select Headings or Word bookmarks. (If the document does not have sections, this area will be grayed out.)
Adobe Acrobat Accessibility Check

With the PDF file open in Adobe Acrobat, select File > Properties and ensure that there is a description of the document in the Title box (under Description). Next, select the “Initial View” tab and under Window Options, change make sure that “Show:” is set to Document Title. Then Save the PDF.
To check for additional accessibility issues within the PDF, select View > Tools > Accessibility

Select “Full Check” and then review any issues that were found. Some issues can be fixed within the accessibility checker by right-clicking on the issue and then select “Fix” (or select any of the options for more info)
Some issues are easier to fix than others. Images require alternate text to describe the image or setting it as decorative. Tables present more complex issues that are difficult to fix with Adobe Acrobat; it is suggested that accessibility issues be fixed with the Office document before generating the PDF. Some PDF accessibility issues may not be easily resolved in a timely manner and therefore need not be resolved.

**Additional Resources:**
- Techniques for WCAG 2.0
- Microsoft Office Accessibility Center
- Making content accessible to everyone
- Make your Word documents accessible (Microsoft)
- WebAIM: Creating Accessible Documents (in Word)
- Creating and verifying PDF accessibility
- PDF Techniques for WCAG 2.0
- WebAIM: Converting Documents to PDF
APPENDIX A

MONTANA UNIVERSITY SYSTEM

New Postsecondary Educational Program/Center/Institute Proposal Process

* New postsecondary educational program as defined by BOR Policy 303.1-Curriculum Proposal

**Request to Plan**

1. Request to Plan (RTP) document completed by campus for proposed new program.
2. RTP submitted to Flagship Provost with appropriate signatures. Affiliate campuses include campus CAO and CEO signature.
3. RTP submitted to DC by Flagship Provost or CC CAO with all appropriate signatures.
4. DC shares RTP with CAOs, CROs, Commissioner and Flagship Presidents.
5. RTP discussed at the next CAO/BOR call. If major issues surface, DC will become involved and DC and Commissioner will determine if BOR consideration of the RTP should be delayed.
6. With no issues, RTP will proceed to consideration by the ARSA committee of the BOR. DC will work with ARSA committee to determine if any committee comments should be incorporated into ITP prior to BOR consideration.
7. ITP proceeds to BOR for consideration and vote.

**Level II Proposal & OCHE Approval**

1. Full Level II proposal received by OCHE on rolling monthly basis.
2. Proposal reviewed by the Commissioner or his designee.
3. Proposal shared with CAOs via Level II memorandum and discussed on monthly CAO call.
4. CAOs have until the Friday following the CAO call to submit final comments. OCHE will review and determine if the proposal is approved.
5. Within one week after the monthly CAO call, OCHE will finalize approvals and inform the CAOs of the decision.

**New Program Review**

Year 3 from launch:
1. OCHE compares headcount to campus projections.
2. Programs below projected headcount submit follow-up materials, which appear as information items on the November BOR agenda.

Year 5 from launch:

**Meets target:** Enters mature program inventory.

70-100% of target: Campus submits follow-up materials and plan. ARSA Deputy Commissioner submits recommendation to BOR, who votes to place in moratorium or continue.

<70% of target: Program placed into moratorium. No BOR action required.

**Campus Mission**

Annual submission of an Academic Priorities and Planning Statement

*Any mention of submission to or review by Flagship Provost or President does not apply to the Community Colleges. All review prior to submission will take place by the Board of Trustees and materials will be submitted directly to OCHE.*
APPENDIX B - GUIDELINES ON PROPOSING RESEARCH CENTERS/INSTITUTES

The objective of this policy statement is to promote the orderly development of Research Centers/Institutes through written guidelines, including the acknowledgment of responsibilities of individuals and administrative units in their operation and appropriate notification to other MUS units about their function and operation. Research Centers/Institutes are consistent with and further the mission of an institution and are established to promote scholarly activity and/or support teaching, research, diversity or the outreach mission of the institution.

Research Centers/Institutes differ from one another in focus, scope, and staffing, but each contribute in unique ways to the common goals of expanding knowledge, generating new discoveries and/or having a positive impact on society through informing policy and systemic change. Communities of researchers and staff in Research Centers/Institutes provide a stimulating environment that encourages early researchers and challenges the experienced researcher. Research Centers/Institutes also contribute to the education and training of the researchers of the future by serving as learning environments for students. Interdisciplinary collaborations are promoted by the Research Centers/Institutes both within the institution and among MUS institutions.

Definitions
An exact definition of a Center or an Institute is difficult to construct, due to the varied existing uses of the terms within the MUS, but the following working definitions should suffice for establishing these guidelines. Generally, a Research Center/Institute is created to establish, organize and set into motion a scholarly research or education program that exceeds the interests of a single individual, department or administrative unit. Administered by a “Director,” Centers/Institutes serve as a catalyst, a place of concentrated activity and a focus for interdisciplinary scholarly activity.

Research Center: A single or multi-disciplinary unit, organized to conduct research around a specific theme or topic, and may have some limited involvement in undergraduate and/or graduate education and/or community outreach activities. Centers are characterized by less autonomy and less independence relative to institutes and generally have a narrower scope of research interests, but may also include educational, clinical and/or community outreach activities of a narrow scope. Centers are typically focused on a specific issue, project, or policy concern but often encompass interdisciplinary work spanning various academic fields. The Center’s lifetime is often limited by the time and financial commitment to completing the particular project. Centers are typically located within departments, institutes, and/or schools/colleges. Center directors typically report to chairs, deans and/or institute directors, but deans and/or chairs may recommend an alternative reporting structure, such as a ‘liaison committee’ or advisory board (if required by the sponsor), consisting of multiple chairs or directors from participating departments or divisions. Directors of interdisciplinary centers in which multiple schools/colleges are involved generally report to the dean of the school/college in which the Center director has his/her primary appointment.

Research Institute: A single or multi-disciplinary unit which is organized primarily to conduct research but may also be actively involved in undergraduate and/or graduate education, community outreach, or clinical services. Such entities are characterized by organizational stability, program autonomy, and
a broad program of study. Typically, institute funding is derived from multiple sources rather than a single source (e.g., one grant). They are expected to have substantial external funding, a dedicated administrative staff, commitments from faculty (FTEs), evidence of long-term sustainability, a program of research training and a substantial infrastructure that may include organized fund-raising (advancement) activities. Faculty and research/teaching staff in institutes usually participate in interdisciplinary graduate/undergraduate programs. Directors of Research Institutes based within a single school/college typically report to the dean or chair, although the dean and/or chair may recommend an alternative reporting structure. Directors of interdisciplinary institutes in which multiple schools/colleges are substantively involved, and for which substantial central resources (matching central funds) are committed, may have a dual line of reporting; for example, to a vice provost and (an) appropriate dean(s).
APPENDIX C - GUIDANCE FOR THE FISCAL ANALYSIS FORM

This guidance is intended to encourage transparency and consistency. In some cases, campuses will need to use their judgement to develop estimates that are sensitive to a program’s context. When this occurs, please briefly describe how you arrived at your estimates in the comment box at the bottom of the fiscal analysis form.

Fiscal analyses should set year one as the first year the academic program enrolls students. Please amend the table header to reflect the correct year. C.A.S. or A.A.S. programs approved under the Level I temporary approval process should start their fiscal analysis from the first year of program authorization, noting in the table header which years are actual and which are projected.

Program Information

Award Level:
UG=Undergraduate
GR=Graduate

Program Name
Name of the program as it will appear in your student information system

Program Code:
4-character code for the program as it will appear in your student information system

Enrollment Projections

Headcount:
Estimate the annual unduplicated headcount of students with a declared major or minor within the program.

Credit Hours:
Estimate the average number of credit hours earned per student in program-related curriculum per academic year (fall, spring and summer sessions). “Program-related curriculum” is intended to capture program requirements but exclude general education coursework.

Student FTE:
Calculate student FTE using estimated headcount and credit hours (CH).

Undergraduate: 
\[
\frac{(\text{Fall CH} + \text{Spring CH} + \text{Summer CH}) \times \text{Headcount}}{30}
\]

Graduate: 
\[
\frac{(\text{Fall CH} + \text{Spring CH} + \text{Summer CH}) \times \text{Headcount}}{24}
\]
Revenue

Tuition Revenue (net of waivers):

1. Look up net tuition revenue for the appropriate level of program (undergraduate or graduate) at
   INSERT LINK TO net revenue TABLE (Developed centrally by OCHE)

2. Calculate Tuition Revenue as:

   \[ \text{Tuition Revenue} = Net\ Tuition\ Revenue \times FTE \]

Institutional Support:
Funds reallocated within campus to support the program.

Program Tuition/Fees
Program specific tuition and fees.

Expenditures

Faculty / Staff / GTA FTE
When estimating FTE, salary, and benefits, count only faculty and staff time used to provide program-related
curriculum or administrative support. This is intended to capture curriculum or administrative support offered
largely or primarily as a component of the proposed program (as opposed to general education coursework or
marginal increases in effort by student support staff that serve the student body at large).

Calculate faculty and staff FTE based on local campus practice and collective bargaining agreements. When
faculty have outreach or research obligations or duties in other programs, count only time dedicated towards
the proposed program.